Invisalign® ClinCheck® 3.0 User Guide
# Contents

About this Document ............................................................................................................. 5
Introduction to the ClinCheck® software ............................................................................. 6
Opening a ClinCheck Treatment Plan from the Invisalign® Doctor Site .............................. 6
ClinCheck Treatment Plan Example for Invisalign Full ....................................................... 10
Basic Tasks for Invisalign Full Treatment Plan Review ...................................................... 11
  ClinCheck Menu Bar ............................................................................................................. 11
  Using ClinCheck Menus ....................................................................................................... 12
  Using the ClinCheck Toolbar ............................................................................................... 14
  Using the Rotation/Translation Control Button ................................................................. 15
  Using Basic Buttons ............................................................................................................ 16
  Using Basic Views Buttons ................................................................................................. 20
  Zooming ............................................................................................................................... 20
  Playing the ClinCheck Animation ....................................................................................... 21
  Using the 2-D Panels .......................................................................................................... 22
  Using the Treatment Panel to Review the Invisalign Treatment Overview ..................... 25
  Using the Comments Tab to Review Invisalign Comment to You ..................................... 28
  Approving a ClinCheck treatment plan ............................................................................. 29
Intermediate Tasks for Reviewing a ClinCheck Treatment Plan ........................................ 30
  Specifying Changes to the Treatment Plan ....................................................................... 30
  Specifying Display Settings ............................................................................................... 31
  Using the View Menu ......................................................................................................... 34
  Gaining Access to Past Treatment Plans ......................................................................... 35
Using Advanced Capabilities .............................................................................................. 36
  Using Advanced Features in the File Menu ....................................................................... 36
  Exporting a Movie .............................................................................................................. 39
  Exporting Screenshots ....................................................................................................... 40
  Advanced Tools Buttons .................................................................................................... 42
  Using the Grid Capability .................................................................................................. 43
  Using the Superimposition Capability .............................................................................. 47
  Using the Attachments Interface ...................................................................................... 50
  Using the Precision Cuts Interface ................................................................................... 59
  Viewing Staging ................................................................................................................. 68
  Using Keyboard Shortcuts ............................................................................................... 70
  Working Offline .................................................................................................................. 70
Treatment Plan Review with Invisalign Assist .................................................................... 71
  Cancelling an Invisalign Assist Treatment ....................................................................... 71
  Using the Animation Control Bar for ClinCheck Animation .......................................... 72
  Using the Treatment Panel ............................................................................................... 73
  Staging Panel Inactive ....................................................................................................... 74
  Advanced Tools Inactive ................................................................................................. 75
Configuration Requirements ............................................................................................... 76
  System Requirements ....................................................................................................... 76
  Hardware Requirements .................................................................................................... 76
  Software Requirements .................................................................................................... 76
  Additional Software Requirements ................................................................................... 76
  Administrator Requirements ............................................................................................. 77
  Adobe Acrobat Reader Version 9 Requirements ................................................................. 77
  Pop-up Blocker Requirements .......................................................................................... 77
  Internet Explorer Requirements ...................................................................................... 77
  Anti-Virus Software Requirements .................................................................................... 78
  Graphics Driver Requirements ......................................................................................... 78
Installing the ClinCheck Software .................................................................................. 79
Downloading the ClinCheck Software .......................................................................... 79
Manual Installation ...................................................................................................... 79
Installing the ClinCheck Software on a Network.......................................................... 80
# About this Document

This document is organized into the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Tasks for Reviewing an Invisalign® Full Treatment Plan</td>
<td>Includes simple tasks that enable you to review the treatment plan quickly and easily. This section is appropriate for doctors who are new to Invisalign.</td>
</tr>
<tr>
<td>Intermediate Tasks for Reviewing a ClinCheck Treatment Plan</td>
<td>Includes additional capabilities that provide you with more information for reviewing the treatment plan. This section is intended for doctors who have some experience with Invisalign and want to take advantage of additional ClinCheck capabilities.</td>
</tr>
<tr>
<td>Using Advanced Capabilities</td>
<td>Includes descriptions of capabilities for advanced users.</td>
</tr>
<tr>
<td>Treatment Plan Review with Invisalign Assist</td>
<td>Describes the differences between Invisalign Full and Invisalign Assist treatment plan review.</td>
</tr>
<tr>
<td>Configuration Requirements</td>
<td>Describes requirements for running the ClinCheck software.</td>
</tr>
<tr>
<td>Installing the ClinCheck Software</td>
<td>Provides installation instructions.</td>
</tr>
</tbody>
</table>
Introduction to the ClinCheck® Software

The ClinCheck software is used for viewing a ClinCheck treatment plan that is developed from a doctor’s orthodontic prescription. The ClinCheck software can also be used to exchange information with Align about any changes the doctor would like to make to the treatment plan. When the doctor approves a treatment plan, aligners are manufactured and sent to the doctor to use in an Invisalign treatment.

Opening a ClinCheck Treatment Plan from the Invisalign® Doctor Site

To open a ClinCheck treatment plan from the Invisalign Doctor site, complete the following steps:
1. Open your browser.
2. Go to the invisalign.com website.
3. Click on the I am a doctor link.

Figure 1. Invisalign.com web site
4. Log in to the Invisalign Doctor Site.

Figure 2. Invisalign Doctor Site login screen

5. Type the Username and Password that you were given in the Clear Essentials I course, then click on the Login button.
6. On the Patient List page, click on the bar for a patient whose status is Review ClinCheck treatment plan.

Figure 3. Patient List page
7. On the Patient File page, click on the View ClinCheck Plan button on the Treatment Lifecycle tab.

Figure 4. Patient File page
ClincCheck Treatment Plan Example for Invisalign Full

Figure 5. ClincCheck treatment plan
Basic Tasks for Invisalign Full Treatment Plan Review

ClinCheck Menu Bar
This section describes individual menus on the menu bar.

Figure 6. ClinCheck menu bar
## Using ClinCheck Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Concepts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>The File menu enables you to perform general tasks:</td>
</tr>
<tr>
<td>Open</td>
<td>• Opening a treatment plan</td>
</tr>
<tr>
<td>Print</td>
<td>• Printing various views</td>
</tr>
<tr>
<td>Print Setup</td>
<td>• Choosing print options</td>
</tr>
<tr>
<td>Recent Items</td>
<td>• Viewing recent treatment plans</td>
</tr>
<tr>
<td>Display Settings</td>
<td>• Specify display preferences</td>
</tr>
<tr>
<td>Exit</td>
<td>• Exiting from the ClinCheck software</td>
</tr>
</tbody>
</table>

**Figure 7. File menu**

<table>
<thead>
<tr>
<th>View</th>
<th>The View menu provides multiple choices for viewing the 3-D model, and an option to view past treatment plans for the same patient.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary View</td>
<td><strong>Figure 8. View menu</strong></td>
</tr>
<tr>
<td>Gallery</td>
<td></td>
</tr>
<tr>
<td>Past Treatment Plans</td>
<td></td>
</tr>
</tbody>
</table>

**Advanced Tools**

<table>
<thead>
<tr>
<th>Advanced Tools</th>
<th>The Advanced Tools menu enables you to gain access to additional features from the ClinCheck toolbar, and open the Custom Attachments and Precision Cuts Interfaces. The Grid and Superimposition buttons are loaded onto the toolbar and the Custom Attachments and Precision Cuts links are added to the Changes panel, so you can use these features whenever you want.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>3D Tools</strong></td>
<td><strong>Figure 9. Advanced Tools menu</strong></td>
</tr>
<tr>
<td>Grid</td>
<td></td>
</tr>
<tr>
<td>Superimposition</td>
<td></td>
</tr>
<tr>
<td>Changes</td>
<td></td>
</tr>
<tr>
<td>Attachments</td>
<td></td>
</tr>
<tr>
<td>Precision Cuts</td>
<td></td>
</tr>
</tbody>
</table>
The Export menu enables you to create visual output in formats that you can print and save (screenshots) or show to your patients so they can view their treatment from beginning to end (movies).

The Help menu enables you to find more information about the ClinCheck software.

The Help Topics menu provides short movies about how to do key tasks with the ClinCheck software.

Check for Updates provides information about updates that are available for the current version of your software.

About ClinCheck provides key technical information about the software and information about how to contact customer support.

The right-click menu appears when you place your cursor anywhere in the ClinCheck display area and click the right button on your mouse. The menu enables you to hide the upper or lower jaw, to select a view to display, or print a screenshot of the display. The menu disappears when you left-click anywhere.
Using the ClinCheck Toolbar

- Use the Rotation/Translation button to move the ClinCheck 3-D model.
- Use the Basic buttons to perform basic tasks for ClinCheck treatment plan review.
- Use the Basic Views buttons to view the ClinCheck 3-D model from different angles.

Figure 13. The ClinCheck toolbar
Using the Rotation/Translation Control Button

The first button on the toolbar toggles between rotation control and translation control.

**Example Model**

![Figure 14. Rotated 3-D model with rotation control cursor shown](image)

The Rotation Control button enables you to move the 3-D model so you can inspect the surfaces from any direction. If you see crossed arrows (Translation Control Button) instead of a circular arrow, click on the button. The circular arrow appears.

- Click in the ClinCheck display area and move the cursor in any direction. The model rotates in the direction the cursor moves.
- **Note:** Clicking on the model is optional.

**Button**

![Figure 15. 3-D model with the translation cursor shown](image)

The Translation Control button enables you to move the 3-D model to another part of the display area without rotating it. If you see a circular arrow (Rotation Control Button) instead of crossed arrows on the button, click on the button. The crossed arrows appear.

- Click anywhere on the 3-D model and drag the model in any direction.
- **Note:** You must click on the 3-D model in order to move the model.
Using Basic Buttons

Buttons

The basic buttons on the ClinCheck toolbar include the following:
- Attach = Attachments
- Num = Numbering
- IPR = Interproximal Reduction
- Over = Overcorrection
- Erupt = Erupting teeth

Concepts

Example Model

The Attachment button enables you to hide or display attachments on the 3-D model. By default, the attachments are displayed.
- To hide attachments, click on the button. The button turns gray.
- To display attachments, click on the button again. The button turns blue.

Button

Attachments are displayed by default as pink shapes on the teeth. You can change the attachment color by selecting File – Preferences.
The Numbering button enables you to hide or display tooth numbers on the 3-D model. Numbers appear on the teeth in the model.

- To display numbers, click on the Numbering button. The button turns blue.
- To hide numbers, click the button again. The button turns gray.

**Note:** You can change the numbering system in the Invisalign Doctor Site clinical preferences. The numbering system you choose displays on the ClinCheck model and on the Invisalign Doctor Site. You can choose the Universal, Palmer, or FDI numbering system.

The IPR button enables you to hide or display IPR information. IPR information is displayed by default.

- To hide IPR indicators, click on the button. The button turns gray and the indicators disappear.
- To display IPR indicators, click on the button again. The button turns blue and the IPR indicators are displayed.

The IPR indicators change color, depending upon the stage.

<table>
<thead>
<tr>
<th>White</th>
<th>Planned IPR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yellow</td>
<td>IPR complete by the current stage</td>
</tr>
<tr>
<td>Gray</td>
<td>IPR finished</td>
</tr>
</tbody>
</table>
The Overcorrection button enables you to view overcorrection in the staging panel. This button is active only if overcorrection is present.

- To hide overcorrection on the staging panel, click on the Overcorrection button.
- To display overcorrection, click the Overcorrection button again.

The red box shows overcorrection from stage 7 to 9 for the upper aligner and from stage 6 to 9 for the bottom aligner. Overcorrection is shown in brown. The Overcorrection button shows the stages of overcorrection that were ordered in the prescription.

When you play the ClinCheck animation, the white bar sweeps across the staging panel. If you click the Overcorrection button off, the movie will stop at the stage before overcorrection so you can see the final position without overcorrection.
The Erupting Teeth button enables you to see the erupting teeth in an Invisalign Teen patient. The button is enabled when there are erupting teeth in the treatment plan.

- To hide erupting teeth, click on the Erupting Teeth button.
- To display erupting teeth, click on the Erupting Teeth button again.

The red box shows the erupting tooth.
Using Basic Views Buttons

Buttons

![Figure 22. Buttons for selecting the basic views for displaying the 3-D model](image)

Concepts

The Basic Views buttons shows the following views of the 3-D model:

- Occlusal mandibular
- Left buccal
- Anterior
- Right buccal
- Occlusal maxillary

Zooming

Controls

![Figure 23. Zoom Controller with vertical or horizontal flags](image)

Concepts and Procedures

The Zoom Controller enlarges or reduces the size of the 3-D model so you can see more or less detail, respectively.

- Click on the plus sign to enlarge the model.
- Click on the minus sign to reduce the size of the model.
- Place your cursor over the flag to move the flag to a horizontal position. Click on the flag and move it to the zoom factor you need. To return to the default zoom factor (200%), click on the Anterior View button in the Basic Views on the ClinCheck toolbar.
Playing the ClinCheck Animation

Animation Control Bar

You can play an animation of the ClinCheck treatment plan, showing tooth movement from the initial state to the final tooth position. The animation is based on stages.

A stage is a discrete step in a ClinCheck treatment plan to accomplish a specified tooth movement for one or both arches. Each stage of tooth movement will correspond to an aligner that will be manufactured for your patient.

One 3-D model depicts the tooth position for each stage. Viewed in sequence, the series of images creates a 3-D animation of tooth movement from beginning to end.

To view the animation, use the Animation Control Bar.

- To play all stages, click on the Play button.
- To pause at any stage, click on the Pause button.
- To go to the first stage, click on the left button.
- To go to the last stage, click on the right button.
- To go to a specific stage, drag the scrubber to the stage.

Concepts and Procedures

Figure 24. Animation controls

Figure 25. Pause button
Using the 2-D Panels

Opening and Closing the 2-D Tabbed Panels

Controls

![Figure 26. 2-D control tabs](image)

Concepts

The 2-D control tabs are located at the upper right corner of the 2-D tabbed panel. They control whether the panel is open, expanded, or collapsed.

Collapsing the Panels

Panels

![Figure 27. Collapsed 2-D panels](image)

Procedure

- To fully collapse the 2-D tabbed panels, click on the left arrow so that the arrow is pointing down. The tabs stay at the upper right corner of the ClinCheck display area, creating more space for the 3-D model. To open a panel, click on the appropriate tab.
**Opening the Panels**

**Panels**

**Procedure**

- To open the panels, click on the left button so that the arrow is pointing up.

---

**Figure 28. Open 2-D panel**
Expanding the Panels

Panels

Procedure

- To expand the panels, click on the right button so that the arrow points to the right.

Figure 29. Expanded 2-D panel
Using the Treatment Panel to Review the Invisalign Treatment Overview

The Treatment tab contains information about the treatment plan, including the following:

- Estimated Treatment Time
- Treatment Overview
  - Attachment and IPR information
  - Aligner Features
- Tooth Movement Assessment

You can navigate to the sections of the Invisalign Treatment Overview by clicking the links at the top of the panel.

Panel

Concepts

- The initial view of the panel begins with links for navigating to different areas in the Treatment panel: Estimated Treatment Time, Treatment Overview, Movement Assessment.
- The next section contains the Estimated Treatment Time section, which gives some guidance on the approximate number of months your patient may be in treatment. This is based on the number of stages in the ClinCheck treatment plan plus a 50 percent buffer in case refinement is needed.
- The following section contains an example of a Treatment Overview for an Invisalign Full treatment. This shows the application of the treatment’s clinical protocols as requested on your prescription.
  - Active Aligner Stages shows the stages that use active aligners in each arch. If present in the treatment, passive, and overcorrection aligners, as well as lingual attachments are shown.
  - A 2-D representation of patient’s teeth shows the amount of IPR, the stages before which IPR takes place, the teeth that will have attachments, and missing teeth.
The second page of the Treatment panel shows the aligner features needed for the treatment. The 2-D diagram shows a flattened version of the aligners so you can see the features on both sides of the aligners.

Symbols show the following:

- **POWER RIDGE**
- **ELASTIC HOOKS**
- **BUTTON CUTOUT**
- **ERUPTION TAB**
- **MISSING TOOTH**

Figure 31. Aligner Features section of the Treatment panel
The red box contains the Invisalign Tooth Movement Assessment section of the Treatment panel. Symbols show the following:

- **MISSING TOOTH**
- **VERY EASY**
- **EASY**
- **MODERATE**
- **ADVANCED**

Click on the “Learn more” link, which goes to the AlignTech Institute site, to find more information about these movements.

**Figure 32. Movement Assessment section of the Treatment panel**
Using the Comments Tab to Review Invisalign Comment to You

The Comments panel contains the most recent communication from Invisalign technicians regarding your ClinCheck treatment plan.

Figure 33. Comments panel
Approving a ClinCheck treatment plan

Buttons

![Cancel and Approve buttons](image)

Concepts and Procedures

- To finalize a ClinCheck treatment plan, click on the Approve button in the ClinCheck window. Approving a treatment plan initiates the process of manufacturing aligners, and constitutes an agreement to pay for the aligners.

- To cancel the order for aligners, based on the treatment plan, click on the Cancel button. When you cancel an order, you are not responsible for any payment. If you wish to resubmit an order at this time, you must begin the process over again.
Intermediate Tasks for Reviewing a ClinCheck Treatment Plan

Specifying Changes to the Treatment Plan

Panel

Figure 35. Changes panel

Concepts and Procedures

To change a ClinCheck treatment plan based on your review and comments provided by Align Technology, complete the following steps:

1. Click on the Changes tab.
2. Type your comments in the upper box.

For effective communication with the Invisalign technician, do the following:

1. Read the ClinCheck comments from the technician.
2. Identify the view on which you are basing your request.
3. Describe the tooth – for example: upper right central incisor. If you click on a numbered tooth on the ClinCheck model, the number appears in your comments.
4. Provide your instructions in bullets and number them.
Specifying Display Settings

The Display Setting dialog has three tabs that show your current preference choices and enable you to set new preferences.

Display Setting

Concepts and Procedures

Colors tab – Enables you to view and set background and attachment colors.

When you first open the ClinCheck treatment plan, you will see the default colors for the active window’s shaded background, tooth numbering, and attachments.

- To change colors, click on a color box and you will see a color chooser. Click on the color you want.
- To return to the default color, click on the Default button.

Figure 36. File – Display Setting – Color tab
<table>
<thead>
<tr>
<th>Display Setting</th>
<th>Concepts and Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Setting</strong></td>
<td>View tab – Enables you view and set values for the display, type of rotation, default zoom factors, and degree of tooth shading.</td>
</tr>
<tr>
<td>Colors</td>
<td>Movies</td>
</tr>
<tr>
<td><strong>Display Control</strong></td>
<td></td>
</tr>
<tr>
<td>Tooth Numbering</td>
<td>ON</td>
</tr>
<tr>
<td>Attachments</td>
<td>ON</td>
</tr>
<tr>
<td>IPR</td>
<td>ON</td>
</tr>
<tr>
<td><strong>Rotation Control</strong></td>
<td></td>
</tr>
<tr>
<td>Precise</td>
<td>Simple</td>
</tr>
<tr>
<td><strong>Zoom</strong></td>
<td></td>
</tr>
<tr>
<td>200%</td>
<td>300%</td>
</tr>
<tr>
<td><strong>Tooth shading</strong></td>
<td></td>
</tr>
<tr>
<td>Light</td>
<td>Medium</td>
</tr>
<tr>
<td>Display patient information</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

*Figure 37. Display Preferences – View tab*
<table>
<thead>
<tr>
<th>Display Setting</th>
<th>Concepts and Procedures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movies tab— Enables you to specify information for movie output. The movies are standalone versions of the ClinCheck animation, which you can store for your own reference and, if you like, show to patients to help them visualize their Invisalign treatment. See <a href="#">Using Advanced Capabilities</a>.</td>
<td></td>
</tr>
</tbody>
</table>

![Display Setting](image)

**Figure 38. Display Preference – Movies tab**
Using the View Menu

View Menu

<table>
<thead>
<tr>
<th>View Menu</th>
<th>Concepts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td></td>
</tr>
<tr>
<td>Secondary View</td>
<td>Posterior</td>
</tr>
<tr>
<td></td>
<td>Anterior Overjet</td>
</tr>
<tr>
<td></td>
<td>Right Buccal Overjet</td>
</tr>
<tr>
<td>Gallery</td>
<td>Left Distal Molar</td>
</tr>
<tr>
<td>Past Treatment Plans</td>
<td>Left Buccal Overjet</td>
</tr>
<tr>
<td></td>
<td>Left Lingual</td>
</tr>
<tr>
<td></td>
<td>Lingual Incisor</td>
</tr>
<tr>
<td></td>
<td>Right Lingual</td>
</tr>
<tr>
<td></td>
<td>Right Distal Molar</td>
</tr>
</tbody>
</table>

The View – Secondary View menu enables you to select additional views to augment the basic views.

Figure 39. View – Secondary View menu

<table>
<thead>
<tr>
<th>View Menu</th>
<th>Concepts</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td></td>
</tr>
<tr>
<td>Secondary View</td>
<td>Single: 1x1</td>
</tr>
<tr>
<td></td>
<td>Occlusal: 1x2</td>
</tr>
<tr>
<td></td>
<td>Composite: 2x3</td>
</tr>
<tr>
<td>Gallery</td>
<td></td>
</tr>
<tr>
<td>Past Treatment Plans</td>
<td></td>
</tr>
</tbody>
</table>

The View – Gallery menu enables you to choose the number of views you want to see in the ClinCheck display area. You can view and manipulate any of the models in the gallery view independently. This capability enables you to examine and compare the model from different viewpoints.

Figure 40. View – Gallery menu
Gaining Access to Past Treatment Plans

Menu

- View
  - Secondary View
  - Gallery
  - Past Treatment Plans

Figure 41. View – Past Treatment Plans menu

Concepts and Procedures

- This feature shows a past history of all ClinCheck treatment plans posted for the patient – initial, mid-course corrections, refinements.

- To view previous treatment plans for the patient, select Past Treatment Plans, and then select the treatment plan you want to see.
Using Advanced Capabilities

Using Advanced Features in the File Menu

Dialog

Figure 42. File – Open dialog

Concepts and Procedures

The Open selection on the File menu enables you to open any `filename.adf` file on your computer. The .adf file contains a ClinCheck treatment plan.

1. When you select File – Open, the standard Windows dialog appears.

2. Navigate to a ClinCheck treatment plan you want to view and select it. Note that the file type is .adf.

3. Click on the Open button.
Dialog

![Print dialog](image)

Concepts and Procedures

The File – Print Dialog enables you to select any of the following options:

- **Current View** – Prints a view of the current model.
- **2 x 3 Gallery View** – Prints the 2 x 3 Gallery View.
- **Changes Tab** – Prints a summary of the changes you have typed in the Changes panel.
- **Staging Tab** – Prints a complete summary of the Staging Panel graph.
- **Treatment Tab** – Prints the Invisalign Treatment Overview.

When you select File – Print Setup, the standard Windows dialog appears.

- Type the required information and click on the OK button.
**File – Recent Items**

### Menu

- **File**
  - Open
  - Print
  - Print Setup
  - **Recent Items**
  - Display Settings
  - Exit

**Figure 45. File – Recent Items menu**

### Concepts and Procedures

The File – Recent Items selection enables you to choose a treatment plan you have reviewed recently.

- Click on or place your cursor over the Recent Items selection in the File menu to show the names of treatment plans you reviewed recently.
Exporting a Movie

Menu

Export
Movie
Screenshot

Figure 46. Export – Movie selection

Concepts

The Export – Movie dialog enables you to create a standalone movie that shows the ClinCheck animation. You can use this movie, for example, to show patients how their treatment will progress, or to enable them to share their anticipated before and after smile with their friends and family.

Dialog

Procedures

1. Select the view you want to show in the movie. The default is to show the animation for the current displayed view. If you want to show the animation for a preset view, click on the Preset View button, and then click on the view.

2. Select the stages you would like to animate. Drag the left triangle beneath the staging bar to the stage where you want to start the movie. Drag the right triangle the stage where you want to stop the movie. The default is to create the movie from the beginning stage to the last stage.

3. Select the movie size, depending on how big you want the movie to appear on your computer’s screen. The default is medium.

4. Select the animation speed. This setting determines the length of the movie. The center setting is the default.

5. Check the Display Patient Information and/or the Display Clinician Information boxes if you want to display this information in the movie. For more information, see Specifying Display Settings. The default is to omit this information from the movie.

6. Click on the Create Movie button.

Figure 47. Export – Movie Settings dialog
Exporting Screenshots

Menu

Concepts

The Screenshot selection on the Export menu enables you to capture a picture of the ClinCheck 3-D model and save it to a folder on your computer. This allows you to store, view, and email the picture.

Dialog

Procedures

The file name for your screenshot appears automatically in the Filename field.

1. Ensure that Save as type is set to JPEG.
2. Click on the Save button.

Figure 48. Export – Screenshot selection

Figure 49. Saving a screenshot of the 3-D model
Dialog

Procedures

1. Open the file where you saved the snapshot on your computer. You will see an icon of your screenshot whose name ends in .jpg. A large picture of your screenshot appears automatically in your browser.

2. If you have more than one file stored in the folder, double-click on the icon for the screenshot you want to view and the screenshot displays in the browser.

Figure 50. Screenshot displayed in your browser
Advanced Tools Buttons

Buttons

![Grid and Superimposition buttons](image)

Figure 51. Buttons for Advanced Tools

Concepts

The Advanced Tools buttons appear on the ClinCheck toolbar only when you mark the appropriate selections on the Advanced Tools menu.

- **Grid** – Displays a grid used for performing linear tooth movement.
- **Superimposition** – Enables you to superimpose the tooth position at any stage in relation to tooth position at any other stage.
Using the Grid Capability

Example Grid

The Grid button enables you to display a grid that can be used to measure linear tooth movements. For more information, see Using the Superimposition Capability.

**Note**: The grid does not provide the ability to measure angular movements such as rotation.

Figure 52. Facial grid with grid tool shown
1. To gain access to the grid dialog, click on the down arrow on the Grid button. The grid dialog enables you to set the orientation of the grid and the grid scale.

2. Select one of the orientations from the Orientation list.

<table>
<thead>
<tr>
<th>Orientation</th>
<th>Used to Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facial (frontal)</td>
<td>Amount of intrusion, changes in midline, and posterior torque</td>
</tr>
<tr>
<td>Sagittal (anterior-posterior; profile)</td>
<td>Amount of anterior-posterior change, and anterior torque</td>
</tr>
<tr>
<td>Occlusal</td>
<td>Amount of expansion and arch symmetry</td>
</tr>
</tbody>
</table>

3. Select your preferred measurement system (millimeters or inches).

4. Set Scale to choose the number of inches or millimeters between grid lines.

5. Click the check box to display the grid tool.

Figure 53. Grid dialog
Using the Grid Tool

Figure 54. Grid tool

Concepts and Procedures

The grid tool (red, green, and blue object) controls the grid position.

- To activate the grid tool, click on the vertical or horizontal sections of the grid tool. The color of the section becomes brighter.
- To rotate the grid, click and drag the grid tool section.
- Without using the grid tool, click anywhere on the grid and drag the grid to the desired location.

Figure 55. Moving the grid tool and the grid
Using the Grid Tool

Figure 56. Moving the grid closer

To move the grid closer to you, click on the center point of the grid tool, then drag the tool upward.

Figure 57. Moving the grid away

To move the grid away from you, click on the center of the grid tool, then drag the tool downward.

Concepts and Procedures
Using the Superimposition Capability

The superimposition capability enables you to visualize relative tooth movement during treatment. Generally, you view superimposition between the initial and final tooth positions, but you can view superimposition between any two stages. This capability enables you to view intrusion, extrusion, expansion, rotation, proclination, and retraction.

Tooth surfaces that become white (by default) are moving toward you. Tooth movements away from you are more difficult to see; however, if you increase the transparency, you are better able to see the tooth movement away from you. For more information on setting transparency, see Figure 59. Superimposition dialog.

Superimposition Example

The Superimposition button enables you to superimpose the tooth position at any stage in relation to any other stage. Typically, you view superimposed initial and final stages.

Figure 58. Model with superimposition

Concepts
Superimposition dialog

Figure 59. Superimposition dialog

Concepts

The Superimposition dialog enables you to set the stage at which you want to show all teeth as blue. The default stage is zero – all the teeth are blue.

As you play the ClinCheck animation, teeth and tooth surfaces become white as they move toward you.

This tool enables you to visualize how teeth move forward or backward, expand, or rotate. For example, with default setting 0, a tooth that is mostly white with a blue side edge shows that the tooth has rotated.

You can also set the transparency of the blue color. Low transparency shows a darker color. High transparency shows a lighter color. The default is halfway between Low and High. Increasing transparency improves your ability to view teeth or surfaces of teeth moving away from you.

Advanced usage: If you choose the last stage as blue, all teeth at stage 0 are white. As you play the ClinCheck animation, teeth and tooth surfaces become blue as they move away from you. Instead of playing the entire ClinCheck animation, you can move the slider to any stage and see the superimposed image at that stage.
Using Superimposition and the Grid

The following example shows how to use superimposition along with the grid to take measurements of tooth movement. The gray areas of the teeth represent tooth position at stage 0. The white areas represent the tooth position at the final stage.

The grid is positioned to measure the model in the upper occlusal view. The red circle shows an area in which the left upper lateral tooth has proclined (moved forward) by 4 mm. The distance is measured between the edge of the white area and the edge of the gray area.

Figure 60. Using superimposition and the grid to measure proclination of the right upper lateral tooth

Concepts
Using the Attachments Interface

The Attachments Interface is an easy-to-use software tool that enables you to add attachments to a treatment plan.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Tools</td>
<td>To enable the Attachments Interface feature, check Custom Attachments on the Advanced Tools menu.</td>
</tr>
<tr>
<td>3D Tools</td>
<td></td>
</tr>
<tr>
<td>□ Grid</td>
<td></td>
</tr>
<tr>
<td>□ Superimposition</td>
<td></td>
</tr>
<tr>
<td>Changes</td>
<td></td>
</tr>
<tr>
<td>✓ Attachments</td>
<td></td>
</tr>
<tr>
<td>□ Precision Cuts</td>
<td></td>
</tr>
</tbody>
</table>

Figure 61. Custom Attachment selected on the Advanced Tools menu
The Attachments link appears on the Changes panel.

- To open the Attachments Interface, click on the Attachments link.
Figure 63. Symbols and Buttons on the Attachment Interface
The Attachments Interface displays the following symbols and buttons:

<table>
<thead>
<tr>
<th>Symbol/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trash bin</td>
<td>When you want to discard an attachment, drag it into the trash bin.</td>
</tr>
<tr>
<td>Attachment types</td>
<td>Different attachments that you can drag and drop onto teeth. The attachments you place display in yellow.</td>
</tr>
<tr>
<td>Pre-placed attachments</td>
<td>The pre-placed attachments are displayed in gray.</td>
</tr>
<tr>
<td>Missing tooth</td>
<td>A blue X mark indicates a missing tooth.</td>
</tr>
<tr>
<td>Back button</td>
<td>Closes the Attachments Interface and opens the Changes panel.</td>
</tr>
<tr>
<td>Reset button</td>
<td>Removes all attachment types you have placed.</td>
</tr>
<tr>
<td>Show lingual</td>
<td>Shows the lingual side of the teeth. The default view is the buccal side.</td>
</tr>
</tbody>
</table>
Drag and Drop

![Figure 64. An attachment dropped onto tooth 3](image)

Procedures

- Drag and drop an attachment type onto a tooth. Note that you cannot add optimized attachments.

Attachment Sizing

![Figure 65. Attachment Size Selection dialog](image)

Procedures

1. To select a size for a vertical or horizontal rectangular attachment, click on the attachment.

2. In the Attachment Size Selection dialog, click on an attachment size, and then click on the OK button. If you do not select a size, the attachment size will be the default, which is "best fit."
Viewing Changes

Figure 66. Attachment additions included on the Changes panel

Procedures

1. To see the effect of your changes, click on the Changes tab. Note that your additions appear in the second section of the Changes panel.

2. To return to the Attachments Interface, click on the Attachments link.
Deleting an Attachment

Procedures

- To delete an attachment, drag and drop it into the trash bin.

- Notice how the attachment on tooth 4 has disappeared.

Figure 67. Moving an attachment to the trash bin

Figure 68. Attachment is removed
Resetting the Treatment Plan

Procedure

- To remove the attachments you have placed and return to the original treatment plan, click on the Reset button.

Figure 69. Reset button on the Attachments Interface
Showing Lingual Surfaces

Procedures

- To view the lingual side of the teeth, click on the Show Lingual button.

1. To add attachments, drag and drop an attachment type to a tooth.
2. Click on the Changes tab to see the results of the additions you have made. To return to the Attachments interface, click the Attachments link.
3. To return to the buccal view, click on the Buccal View button.

Figure 70. The Show Lingual button

Figure 71. View of the lingual side of the teeth
Using the Precision Cuts Interface

The Precision Cuts interface is an easy-to-use software tool that enables you to specify how and where to cut aligners for Class II and Class III treatments.

Menu

| Advanced Tools | 3D Tools | Grid | Superimposition | Erupting Teeth | Changes | Custom Attachments | Precision Cuts |

Procedure

- To enable the Precision Cuts feature, check Precision Cuts on the Advanced Tools menu.
The Precision Cuts link appears on the Changes panel.

- To open the Precision Cuts Interface, click on the Precision Cuts link.
Figure 74. Precision Cuts Interface
The Precision Cuts Interface displays the following symbols and buttons:

<table>
<thead>
<tr>
<th>Symbol/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trash bin</td>
<td>When you want to discard an elastic hook or button cutout, drag and drop it into the trash bin.</td>
</tr>
<tr>
<td>Button cutout</td>
<td>A cutout object that you can drag and drop onto a tooth to request a cutout in the aligners to accommodate a button on a tooth.</td>
</tr>
<tr>
<td>Elastic hooks</td>
<td>A hook object that you can drag and drop onto a tooth to request an elastic hook on the aligner.</td>
</tr>
<tr>
<td>Missing tooth</td>
<td>A blue X mark indicates a missing tooth.</td>
</tr>
<tr>
<td>Back button</td>
<td>Closes the Precision Cuts Interface and opens the Changes panel.</td>
</tr>
<tr>
<td>Reset button</td>
<td>Removes precision cuts you have specified.</td>
</tr>
<tr>
<td>Show lingual</td>
<td>Shows the lingual side of the teeth. The default view is the buccal view.</td>
</tr>
</tbody>
</table>
Drag and Drop

Figure 75. Placement of elastic hooks and button cutouts

Procedure

- Drag and drop a button cutout or elastic hook onto a tooth.
Viewing Changes

1. To see a text version of your changes, click on the Changes tab. Note that your additions appear in the second section of the Changes panel.

2. To return to the Precision Cuts Interface, click on the Precision Cuts link.

Figure 76. Precision Cuts additions included on the Changes panel
Deleting a Precision Cut

Procedure:
- To delete a precision cut, drag and drop it into the trash bin.

![Figure 77. Moving a precision cut to the trash bin](image)

Notice how the elastic hook on tooth 6 has disappeared.

![Figure 78. Elastic hook on tooth 6 deleted](image)

To replace the cut, drag and drop an elastic hook onto tooth 6.

![Figure 79. Replacing the cut](image)
**Reset**

![Image of the Reset button on the Precision Cuts Interface]

**Procedure**

- To remove the Precision Cuts you have made and return to the original treatment plan, click on the Reset button.

---

Figure 80. The Reset button on the Precision Cuts Interface
**Showing Lingual Surfaces**

Figure 81. The Show Lingual button

**Procedures**

- To view the lingual side of the aligners, click on the Show Lingual button.

Figure 82. View of the lingual side of the aligners

1. To add Precision Cuts, drag and drop button cutouts to a tooth.
2. Click on the Changes tab to see the results of the additions you have made. To return to the Precision Cuts Interface, click on the Precision Cuts link.
3. To return to the buccal view, click on the Buccal View button.
Clicking on the Staging tab opens the Staging panel. The purpose of this panel is to show a 2-dimensional version of the treatment plan per tooth. When you plan the ClinCheck animation, a vertical line sweeps across the Staging panel to help you see the state of the treatment at every stage.

- The numbers on the left and right sides of the panel indicate the tooth number.
- The numbers at the top of the panel indicate the stage number.
- The horizontal lines indicate the type of aligner used.
- Blank spaces in a line means that there is no movement planned in the aligner for the tooth at that particular stage.

<table>
<thead>
<tr>
<th>Horizontal Line Color</th>
<th>Type of Aligner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Active aligner</td>
</tr>
<tr>
<td>Gray</td>
<td>Passive aligner</td>
</tr>
<tr>
<td>Brown</td>
<td>Overcorrection aligner</td>
</tr>
</tbody>
</table>

Figure 83: Staging panel showing overcorrection and passive aligner
Symbols indicate the event that happens at a particular stage.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Event at a Particular Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>❀ ❀ ❀</td>
<td>IPR</td>
</tr>
<tr>
<td>White</td>
<td>Planned IPR</td>
</tr>
<tr>
<td>Yellow</td>
<td>IPR complete by the current stage</td>
</tr>
<tr>
<td>Gray</td>
<td>IPR finished</td>
</tr>
</tbody>
</table>

Note that the IPR colors change as the staging line sweeps across the panel.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Event at a Particular Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>↓</td>
<td>Attachments placed</td>
</tr>
<tr>
<td>↑</td>
<td>Attachments removed</td>
</tr>
</tbody>
</table>
Using Keyboard Shortcuts
You can use keyboard shortcuts to translate and rotate the model, and to zoom in and zoom out.

Using the Keyboard and Mouse
- Position your cursor over the 3-D model.
- To translate the model, press and hold the Shift key while moving the mouse in the direction you want the model to move.
- To zoom in or zoom out, press and hold the Ctrl (Control) key while moving the mouse up or down.

Using the Keyboard Only
- To zoom in or zoom out, press Ctrl (Control) while you press one of the directional arrows on your keyboard. Press up or right to zoom in. Press down or left to zoom out.
- To rotate the 3-D model, press Shift and one of the directional arrows on your keyboard (up, down, left, or right).

Working Offline
The primary way to gain access to ClinCheck treatment plans is online, on the Invisalign Doctor Site, but you can also work offline (without an internet connection) with the Invisalign Patients Viewer.

**Note:** When you work offline, you will **not** be able to submit changes or approve a ClinCheck treatment plan.

When you open a ClinCheck treatment plan online on the Invisalign Doctor Site, the treatment plan is saved locally on your computer in the Invisalign Patients Viewer. This viewer is installed on your desktop when you install the ClinCheck software. The Invisalign Patients Viewer displays a list of ClinCheck treatment plans stored on your computer – samples supplied by Invisalign in addition to your treatment plans.

- To open the Invisalign Patients Viewer from the desktop, double-click on the Invisalign Patients Viewer icon on your computer’s desktop.
- To open the Invisalign Patients Viewer from the Start menu on your computer, select All Programs, then Align, followed by ClinCheck 3.0, and Invisalign Patients Viewer.
- To open a treatment plan, click once on the bar beneath the patient’s name. For sample treatment plans, click on the bar beneath the treatment name.
Treatment Plan Review with Invisalign Assist

Reviewing a ClinCheck treatment plan for the Invisalign Assist® option is similar to reviewing a ClinCheck treatment plan for the Invisalign Full option. The differences are presented in this section.

Cancelling an Invisalign Assist Treatment

Buttons

![Buttons](image)

Figure 84. Cancel and Approve buttons in Invisalign Assist

Concepts and Procedures

- To approve a ClinCheck treatment plan, click on the Approve button. This process is the same as the process to approve an Invisalign Full treatment plan.

- You have 3 other choices: Cancel, Switch, and Refer.

  - Cancel stops the treatment plan review process. No aligners are manufactured. For any cancellations, you are not responsible for payment.

  - Switch enables you to change to a different treatment option, such as Invisalign Full.

  - Refer enables you to refer a patient to a different doctor.
Using the Animation Control Bar for ClinCheck Animation

Animation Control Bar

Concepts and Procedures

On the Animation Control Bar, the scrubber does not include numbers, nor does the area to the right of the animation bar controls. This is because progress tracking might result in some changes to ClinCheck staging.

The process of playing the ClinCheck animation is the same as the process of playing an animation in the Invisalign Full interface – using the animation controls.

- Drag the scrubber to any location on the animation control bar to see the estimated tooth position.
Using the Treatment Panel

Treatment Panel

Concepts

The Treatment Panel shows the following:

- An overview of the treatment, which includes:
- IPR and attachments needed in treatment
- Aligner features included in the treatment
- Guidance on tasks to perform at each patient appointment

At the top of the panel, there are links for each appointment. When you click on a link, the scrubber moves to the location on the animation control bar for that appointment and the ClinCheck model moves to the estimated tooth position for that appointment.
Figure 87. Inactive staging tab

Because progress tracking is an integral part of Invisalign Assist, the treatment plan might change. Specific stage information including stage numbering is not displayed, so the staging panel is not needed.
Advanced Tools Inactive

Panel

Concept

If you previously selected Custom Attachments or Precision Cuts on the Advanced Tools menu, then the links are disabled on the Changes panel. These features are not available for the Invisalign Assist treatment option.

Figure 88. Attachments and Precision Cuts links inactive on Changes panel
Configuration Requirements

System Requirements

In order to view ClinCheck treatment plans and return feedback to Invisalign, you must have internet access and your computer should meet the minimum specifications below.

Note: The ClinCheck software currently runs only on the PC platform: Windows XP SP2, XP SP3; Vista (any SP); Windows 7; Server 2003 SP2 or RC2; and Server 2008 SP2 or RC2.

Hardware Requirements

Minimum Requirements
- Intel® Pentium 4™, 1.6 GHz or compatible
- 512 MB RAM
- Minimum of 1 GB free disk space
- High-Speed Internet (DSL, Cable Modem, or equivalent)
- Acceleration technology supporting 3-D graphics via Open GL. Add-on graphics card with 128 MB of dedicated (unshared) memory, or integrated video chipset.

Recommended
- Intel® Pentium 4™, 3.2 GHz, Intel Core 2 Duo 2.0 GHz or compatible
- 1024 MB RAM or more
- Minimum of 2 GB free disk space
- High-Speed Internet (DSL, Cable Modem, or equivalent)
- Acceleration technology supporting 3-D graphics via Open GL. Add-on graphics card with 256 MB of dedicated (unshared) memory, or integrated video chipset.

Software Requirements

Minimum Requirements
- Windows XP SP2, 32-bit
- Internet Explorer 7
- 1024x768 Display Resolution
- 32 Bit True\Color Palette Settings
- Adobe Acrobat Reader Version 9 (New)
- Graphics driver not older than 1 year

Recommended
- Windows XP SP 3 or Windows Vista
- Internet Explorer 7 or above
- 1024x768 display resolution or higher
- 32 Bit True\Color Palette Settings
- Adobe Acrobat Reader Version 9 (New)
- Latest graphics driver

Additional Software Requirements
- Administrator rights for installation
- Read / Write access to the C:\Program Files\Align folder and ALL subfolders
- ActiveX allowed on local system
- Activated SSL 3
- Protection hardware/software must be configured accordingly to allow the Invisalign Doctor Site to send / receive data (allow port 80 for http and port 443 to https for inbound and outbound)
Administrator Requirements
Before beginning installation, ensure that you have Administrator rights on your computer.

1. On your desktop, right-click My Computer, and then select Manage.
2. In the left pane, expand System Tools, and then click on Local Users and Groups.
3. In the right pane, double-click Groups.
4. Double-click Administrators. If your name appears in Members you have Administrator rights.
5. If you do not have Administrator rights, have your Administrator assign you Administrator rights.

Adobe Acrobat Reader Version 9 Requirements
2. Download Acrobat Reader Version 9 (or higher) from this website.

Pop-up Blocker Requirements
The ClinCheck software relies on several pop-up windows to function. If you have pop-up blocking software installed it may prevent ClinCheck and other VIP tools from operating correctly. Many pop-up blockers are available commercially. These pop-up blockers can be configured to allow pop-ups from specific websites. Consult the pop-up blocking software help files for more information on how to configure this feature. Usually you will need to indicate a root URL in your configuration to allow pop-ups from specific web sites. Use the following values to configure the ClinCheck software:

- http://*.aligntech.com
- http://*.invisalign.com

As an alternative to configuring your pop-up blocking software, you may choose to turn off any pop-up blocker when using ClinCheck to avoid a conflict.

Internet Explorer Requirements
The ClinCheck software is designed to work with the default security settings for Microsoft Internet Explorer. If your browser security settings have been changed you may not be able to access the ClinCheck software. Follow the steps below to check your settings and return the security settings to their default level:

1. Open Microsoft Internet Explorer.
2. From the Tools menu select Internet Options.
4. Select Trusted Sites.
5. Click the Sites button.
6. Click inside Add this website to the zone:
   a. Type https://*.invisalign.com and click the Add button.
   b. Type https://*.aligntech.com and click the Add button.
7. Click Close.
8. Click OK.

**Anti-Virus Software Requirements**

You must configure your anti-virus software if it is installed in your computer to allow the ClinCheck software to communicate with the servers running the Invisalign service. For information about configuring your anti-virus software, ask your computer support technician or contact Align Customer Care. You can find information about Align Customer Care on the Support page on the Invisalign Doctor Site.

**Graphics Driver Requirements**

The ClinCheck software displays 3D models that require up-to-date graphics drivers. To obtain help installing the graphics driver software, ask your computer support technician or contact Align Customer Care. You can find information about Align Customer Care on the Support page on the Invisalign Doctor Site.
Installing the ClinCheck Software

Automatic Download for Existing Users
Respond to offer for update
When a new version of the ClinCheck software is available, a pop-up dialog will display, asking you whether to install the new version.
- Click Yes.

Downloading the ClinCheck Software
Install the ClinCheck software from the Invisalign Doctor Site
1. Log into the Invisalign Doctor Site.
2. Click on the Support tab.
3. Click on the Software download link and download the ClinCheck software.

Installation for New Users
Install the ClinCheck software from the CD
1. Insert the Invisalign software bundle installer CD into your CD drive. This is the CD you received in the Clear Essentials I course. The InstallShield Wizard dialog box displays.
2. Follow the on-screen instructions and begin using the ClinCheck software.

Complete the ClinCheck software installation
A window displays asking you if you want to view documents.
1. Select the documents that you want to view, and click on the OK button.
2. When the documents display, read them. Print them, if desired.
3. Close the documents.
4. If you chose Open Invisalign Patients, the Invisalign Patients Viewer opens.
5. If you did not choose Open Invisalign Patients, open a treatment plan from the Invisalign Doctor Site.
Installing the ClinCheck Software on a Network

You can set up a single Invisalign Patients Viewer for access by multiple computers and users on a network. By default, an Invisalign Patients Viewer is installed on each local machine where the ClinCheck software is installed. You must install the ClinCheck software on each computer in the network; however, all those computers will have the ability to share a common, centralized Invisalign Patients Viewer.

1. Install the ClinCheck software on the computer where you want to locate the Invisalign Patients Viewer.

2. Share the Invisalign Patients Viewer:
   a. From your Start menu, select My Computer.
   b. Click on Local Disc C.
   c. Click on Program Files.

3. Click on Align. (The default location is C:\Program Files\Align)

4. Right click on the Invisalign Patients folder icon and select Properties.
   a. Click the Sharing tab, and select Share This Folder. By default, the share name is Invisalign Patients.
   b. Select the Security tab.
   c. Click Add, and then add the Windows user accounts of all individuals who need access to the Invisalign Patients Viewer.
   d. Click OK.
   e. For each Windows user you have added, click on (highlight) the user’s name, then click the Permissions box in the Allow column to assign privileges for the user.

5. When you are finished with all users, click Apply.

6. To find the share name and computer where you installed the Invisalign Patients Viewer, complete the following steps:
   a. In Windows, right click on the My Computer icon (or go to the Start menu and select My Computer) and select Properties.
   b. Select the Computer Name tab. The full computer name is displayed here.
   c. Write down the computer name. You will need this name for the next step.
   d. Click OK.

7. Install the ClinCheck software on all computers that need access to the Invisalign Patients Viewer.
   a. Use the installation instructions to install the ClinCheck software on each computer in your network. The Installation Wizard displays. Follow the onscreen instructions.
   b. In the Choose Destination Location dialog, click Browse, then enter the Network Path of the Invisalign Patients Viewer you previously installed.
   c. Enter the path as \COMPUTERNAME\SHARENAME, where COMPUTERNAME is the name of your computer and the SHARENAME is “Invisalign Patients.”

8. Click the Next button and continue with the installation.